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1. INTRODUCTION  

FormWorks Plus prepares the text files required for a VecTor5 analysis, using a graphical interface. 

This document will allow a user to learn the FormWorks Plus program. Developing an understanding 

of this program will also allow the user to better understand the VecTor5 program and the input text 

files required. When a structural model is being created, FormWorks Plus will create the input text 

files required for the VecTor5 analysis as follows: Structure Data File (.S5R), Load Data Files (.L5R), 

Job Data File (.JOB), and the Auxiliary Data File (.AUX). All these files, the FormWorks model 

(.fwd), and the VT5.exe program should be placed in the same folder. 

To better understand the VecTor5 program and the process behind the FormWorks Plus graphical 

interface, it is highly recommended to read the User’s Manual of VecTor5 and the User’s Manual of 

Janus for VecTor5, both of which can be downloaded here. Watch and Learn videos can be found 

here. These videos show how to use the programs to model various structures. 

2. CREATE A STRUCTURAL MODEL 

When FormWorks Plus is opened, the following dialog box appears. This allows the user to select the 

type of structure that needs to be modeled. Select the icon for VecTor5 (VT5). 

 

FormWorks Plus has the menus laid out in the taskbar so that the user can create and modify a 

structure. The taskbar is shown below: 

http://www.utoledo.edu/engineering/faculty/serhan-guner/Publications.html
https://www.youtube.com/user/gunerser
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The menus that are necessary for structure creation are discussed in detail within this manual. 

To load an existing structure, click the Open icon, shown below, which is located at the top left corner 

of the screen. Then, select the file with the “.fwp” extension to load the model. 

 

To save the structure model, click on the Save icon. It is recommended that you save frequently.  

 

Upon opening a model, the screen should look something like the following image. Various parts of 

the structure are labeled in red annotation. Please note that if this is your first model with FormWorks 

Plus, you need to create it from scratch executing the tasks starting from Section 2.1.  
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The frame above is shown with the members and node numbers laid out. The axial loads are shown 

for the load case 1, as 400 kN in the negative Y-direction, applied to nodes 1 and 3. The support 

restraints are also shown at the base of the structure, which are restraining nodes 5 and 38 in the X, 

Y, and Z-degrees of freedom. The red joint regions signify that semi-rigid end offsets were defined at 

the joint connections, which is important to remember during meshing.  

2.1  Define Job 

The first icon displays the Define Job menu. In this menu, the Job information is input. This 

information includes the number of load stages, type of loading, and loading increments. The load 

cases are also defined here. There are five possible load cases that can be applied to a single structure. 

At the top of the menu, the ‘Job Control’ tab allows the user to select the type of analysis calculations 

that are performed. These are explained in more detail in the User’s Manual for VecTor5. Note that 

it is no more accurate for more load stages to be defined; just use enough so that the structure fails. 

The increment factor should be used to determine the increments for the loading. The following image 

shows an example structure that has been modeled using FormWorks Plus. Note the increasing load 

in Load Case 1 and the constant load in Load Case 2. The Load file name (in this example, HL for 

the horizontal load and VL for the vertical load) can be specified by the user as desired. 

 

Support 

restraint (typ.) 

Member (typ.) 

Node (typ.) 

Doubled rebar 

member (typ.) 

Open 
Save 
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The next tab on this screen is the ‘Material Behavior Models’ tab. There are several options, which 

should typically left as default, except the concrete pre-peak response model. Typically, Hognestad 

Parabola and Popovics (NSC) are used for normal-strength concrete (f’c < 50 MPa). When creating a 

structure with high-strength concrete (f’c > 50 MPa),  the Popovics (HSC) or Hoshikuma model 

should be selected. For more information about these options, refer to pages 10 and 11 of the User’s 

Manual of VecTor5. 
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2.2  Define Material Properties & Cross-Sections 

The next menu is to Define Material Properties. In this menu, the user will create the cross-sections 

for the members that will be meshed throughout the structure. The concrete compressive strength, 

tensile strength, cylinder strain, among other values can be input. Note that the values required for 

input depends on the material model being selected (Hognestad Parabola, Popovics, etc. – refer to 

pages 10 and 11 of the User’s Manual of VecTor5). If the values with an asterisks are left as zero, 

they will be calculated by the program VecTor5. In addition, the shear reinforcement properties are 

input in this menu on the right side of the dialog box. If the material properties are known (i.e., from 

an experimental testing), input them fully into this menu. If the properties are unknown, a steel grade 

can be selected via the dropdown menu. 300R refers to steel with a yield strength of 300 MPa or 43.5 

ksi; 400R refers to 400 MPa or Grade 60 steel (58 ksi); 500R refers to 500 MPa or Grade 70 steel 

(72.5 ksi); and 400W refers to Grade 60 steel (58 ksi) which is weldable. 

 

 

Upon clicking “Next”, the following menu appears. This menu is used to generate the concrete layers 

for the cross-section, which is based on the properties of the stirrups that are specified and the 

dimensions of the cross-section. Four input fields above the generate button should be filled out. It is 

recommended to specify a layer thickness to provide approximately 30 concrete layers. The values 

for Rho-t and Rho-z are automatically calculated upon clicking the “Generate” button.  
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Clicking “Next” will display the following dialog box. In this menu, the longitudinal reinforcement 

is defined. To create the reinforcement, enter the properties and the Ys distance from the top of the 

cross section, and simply click “Add”. For the top and bottom reinforcement adjacent to the stirrups, 

Top1 and Bot1 options can be used. For all other layers, calculate and input the Ys distances manually. 

Once the reinforcement has been created for each section, click “Done” to exit the menu. If the 

properties are unknown, a steel grade can be selected, as explained above. 

 

2.3  Define and Mesh Structure 

Once the materials and cross-sections have been added, the next step is to open the Define and Mesh 

Structure menu, shown below. This dialog box allows the user to enter the coordinates of the structure 

to determine which member types (i.e., cross-sections) span between each set of coordinates. 

FormWorks Plus will mesh the structure and create the members automatically. To begin, click 

“Create New Region” and add the X and Y-coordinates for which the member type will be assigned. 

Then, in the Material Layers area, select the cross-section that will span between these coordinates. 
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Click “Add Region” to incorporate this region into the structure. Regions can be added as needed to 

achieve the desired structure. One region for each beam or each column is typically required as 

minimum. If the cross section or reinforcement details change within a beam or column, more regions 

are needed. If a point load is to be applied, a node should be defined at the load application point. The 

menu shown below represents an example of how these regions might be defined when creating a 

model. As previously mentioned, be sure to check “Double Rebar at Joints” to use semi-rigid end 

offsets. Note that the member length is automatically calculated to be approximately half of the cross 

section. Optionally, if an exact member length is desired, the user can input the exact number as Elmt. 

Size. The optimum member length is between 40% and 60% of the cross-sectional height.  

 

 

Once the regions have been added, move to the ‘Create Mesh’ tab. Once there, click “Create Mesh” 

and “Add Mesh to Structure” to allow FormWorks Plus to form the structure with nodes and members. 

The example shown below represents a structure with 70 nodes and 70 members, with 6 restraints. 

Then, click “Done” to exit the Define and Mesh Structure menu. 
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2.4 Create Support Restraints 

Once the structure has been created, the Create Support Restraints menu must be opened. In this 

menu, the user will define the supports for each node based on the degrees of freedom to be restrained 

in each direction. To add a support, select the node number, degrees of freedom, and click “Add”. 

Note that the Pointer and Window selection modes are also available.               

 

 

2.5 Element Output List 

The Element Output List is important for viewing the analysis results in the Janus postprocessor. All 

elements should typically be selected for the detailed output. To create the output list, click on the 
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Window option and select the entire structure. The following menu shows an example list from a 

structure that was modeled using FormWorks Plus.  

 

 

2.6 Move Nodes 

This menu is optional and can be used to slightly adjust the node coordinates. To move a node, enter 

the node number and the distance in the X and Y-directions. Note that you cannot add a node using 

this process. The Pointer and Window selection modes are also available. 

 

 

2.7 Reassign Material Types 

When meshing a structure, the materials are assigned to the elements as the regions are created. The 

Assign Material Types menu is useful for changing the material type of an element(s) to correct a 

mistake or to create new regions after the structure is meshed. Note that the elements can be selected 

via the Pointer and Window selection modes. 
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2.8 Optional Advanced Features 

FormWorks Plus offers various features that are not necessary for a beginner, but may be valuable for 

the experienced users under certain situations. Please note that these options cannot be used with the 

auto-meshing feature, which is the recommended procedure for typical structures. 

2.8.1 Create Nodes 

If desired, the user can view and create nodes using the Create Nodes menu shown below. To create 

a node, enter the coordinates of the node and click “Add”. This menu is not necessary, but is optional 

if more nodes are desired. The menu below shows an example of nodes from a structure that was 

modeled using FormWorks Plus.  

 

 

2.8.2 Node Copy 

Another menu which is optional, and typically not required, is the Node Copy menu. The user can 

copy nodes that have been created within the structure. To copy a node, enter the node number and 

the distance in the X and Y-directions. 
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2.8.3 Create Frame Elements 

When auto-meshing the structure, the frame elements are automatically created. This menu is for 

manually creating each element without using the auto-mesh feature. Shown below is the icon and a 

screenshot of the menu. To add an element, type the element number and choose the nodes that it 

must span between. The menu shown below is from a structure that was modeled using FormWorks 

Plus.  

 

 

3. APPLYING LOADS 

Now that the structure has been created, it is time to apply various loads so that an analysis can be 

performed. Each type of available loading is discussed. Note that each load case can have multiple 

loadings associated with it. Be sure to input the correct loading factors and increments in the Job file, 

so that the structure is loaded properly. 

3.1  Apply Nodal Loads 

The first available load type is applying a load to the nodes of a structure. To apply a nodal load, click 

on the following icon to display the corresponding menu. Then, enter the desired node and the loading 
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to be applied in the corresponding direction. Positive moments are in the counterclockwise direction. 

Nodes can also be selected via the Pointer and Window selection modes. 

 

 

3.2  Apply Support Displacements 

Another load case option is to apply a support displacement. This is useful when performing a 

displacement-controlled analysis. Enter the desired node, and select the direction for the displacement 

to be applied by clicking the direction under the D.O.F. Enter the displacement amount, which may 

be 1 millimeter for a displacement-controlled analysis, into the appropriate box. This value will be 

controlled through the Job file. Note that the nodes can also be selected via the Pointer and Window 

selection modes.  

 

 

3.3  Apply Gravity Loads 

The next loading option is to apply gravity loads throughout the structure. This loading refers to the 

self-weight of the structure. To apply a gravity load, choose the icon shown below. In the menu, enter 

the factor of gravity load, which is typically -1 in the y-direction. Then, choose the elements to which 

the load is to be applied, which can be done via the Pointer and Window selection modes. Typically, 

all elements should be selected. Please note that for a frame structure with slender members, the self-

weight will be small and may be neglected. 
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3.4  Apply Concrete Prestrains 

Another loading option is to apply prestrain, or shrinkage strain, to the concrete. To apply the 

prestrain, choose the following icon to open to menu. Then, enter the elements to which the strain is 

to be applied, and the value for strain. A typical value of -0.2 millistrain (me) represents a small 

shrinkage strain. Note that the elements can also be selected via the Pointer and Window selection 

modes.  

 

 

3.5  Apply Impulse Forces 

The user can also choose to apply impulse forces to the structure. These forces are used to perform a 

dynamic impulse analysis. In this menu, enter the desired nodes, degrees of freedom, as well as the 

impulse force F (kN) and the corresponding time T (s) to be applied. Note that the nodes can also be 

selected via the Pointer and Window selection modes.  

 



17 

 

 

3.6  Apply Temperature Loads 

If loading due to temperature changes or fire is present, choose the following icon to show the menu. 

Enter the desired elements, as well as the temperature differential and the elapsed time. The reference 

temperature refers to room temperature and the elapsed time is the exposure time. Note that the 

elements can also be selected via the Pointer and Window selection modes.  

 

 

3.7  Apply End Action Loads 

Another form of loading is to apply end action loads to the structure. This can be done by selecting 

the following icon to show the menu. This loading is used less frequently.  Enter the desired element, 

and the axial, shear, and bending moment for each node of the element. The info button gives more 

details on this load. Note that the elements can also be selected via the Pointer and Window selection 

modes.  
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3.8  Apply Concentrated Loads 

The next type of loading is a concentrated load. This option is useful when a point load is applied in 

between the nodes. Upon clicking the following icon, the menu appears. Enter the desired elements, 

and the forces, moments and X/L ratio. The information button gives more details on this load. Note 

that the elements can also be selected via the Pointer and Window selection modes.  
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3.9  Apply Uniformly Distributed Loads 

The user can also apply uniformly distributed loads to the structure. This load is useful when modeling 

the floor loading. To do this, click the following icon to show the menu. Enter the desired elements 

for the load to be applied, as well as the value for the load and the a/L and b/L ratios. The information 

button gives more details on this load. Note that the elements can also be selected via the Pointer and 

Window selection modes.  
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3.10  Clear Load Case 

The final icon is located at the far right end of the taskbar. This icon allows the user to clear the current 

load case that is selected. This may be useful if the user wishes to delete or replace an entire load case. 

Upon clicking this icon, the following message appears on the screen. Choosing “Yes” will clear the 

load case from all members and nodes. 

 

 

4. DISPLAY OPTIONS 

The Display Options menu is useful for viewing the structure in FormWorks Plus. There are options 

to display node and element information. One of the most useful features of this menu is the ability 

to show the bottom of the element. This way, the user can ensure that each element is oriented properly 

throughout the structure. To do this, be sure to check the “Frame Element Bottom (VT5)” checkbox. 

The bottom of each element is indicated with a black line as shown in the image below. 
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5. PERFORMING AN ANALYSIS 

Once the structure and loading have been created, you can perform a VecTor5 analysis.  For this, you 

need to save the input text files created by FormWorks Plus into the folder which contains VT5.exe 

program. To save the individual files, click on the following save icons. The red icon saves the Job 

file, the blue icon saves the Structure file, and the green icon saves the Load file.  

 

Now that the files have been saved, the VecTor5 analysis program can be activated using the 

following icon. This icon is located adjacent to the save icons discussed above. Alternatively, the 

analysis may be initiated by going into the folder and double clicking on VT5.exe file.  

 

Upon clicking on the VT icon, the following screen appears, showing that the processor VecTor5 is 

performing the calculations and creating an output file for each load stage. These files are readily 

available for review in the folder where all files are saved, which is shown below. These files can be 

opened and viewed using Notepad or other text editors. Expanded data (.S5E) and expanded load files 

(.L5E) are particularly important to check for the input and modeling mistakes. They list all input in 

a tabular format for visual inspection. Material properties calculated by VecTor5 should also be 

checked for accuracy using the .S5E file. For example, check the Ec and e0 values to ensure that they 

match the values that you wish to use. For more information about the VecTor5 processor and the 

files it produces, please refer to the User’s Manual of VecTor5. 
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5.1 Retrieving Output Data 

To access the data files that VecTor5 has created, go to the folder where it has saved the files shown 

above. To obtain the load-deflection data, it is necessary to copy the “VT5Data_X.exe” or 

“VT5Data_Y.exe” programs into this folder. This folder is also where the Job, Structure, and Load 

files are saved by the FWP program. Once the data program is copied, open the file to generate the 

following window. In this window, enter the information as the program prompts. For this example, 

the reaction node is 1, and the nodal displacement is applied at node 7. In a displacement controlled 

analysis with a single displacement applied, the same node number should be input for both the 

reaction and the displacement. This is due to the fact that VecTor5 calculates the reaction for the 

applied displacement at this node. 

  

Once the information is entered, click “Enter” to allow the program to read the output data files one 

by one. Once completed, a text file named “results.dat” will be generated in the same folder. Open 

this file to view a tabulated list of the load versus deflection data for the beam, respectively. Copy and 

paste this information into Excel or a graphing program to create charts and graphs to display the data. 

The Results data file for a beam is shown below, where the nodal displacement is in the left column 

and the reaction is in the right column. 
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For this beam, the following graph can be created for the Load versus Deflection data obtained. The 

load is at node 1, the deflection is at node 7. The experimental data for this beam (VS-A1), was 

obtained from the journal paper of Vecchio and Shim (2004). 

 

5.2 Troubleshooting 

There may be times when the VecTor5 processor displays an error message and will not perform the 

analysis. In most cases, the black DOS screen will pause and show the error message. If this window 

closes before displaying the error message, you need to initialize the VT5.exe using the command 

prompt. For Windows operating systems, right click on the start menu and select Command Prompt. 

Type CD xxx, where xxx is the full file path of the folder containing all analysis files. You can copy 

(Ctrl + C) and paste (Ctrl + V) this path from the title bar of Windows File Explorer. Then, type 

VT5.exe into the DOS window. This will initialize the program and show the error message.  
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Errors for to the stiffness matrix, such as being not positive definitive, is commonly related to the 

support conditions. Check the model to ensure that at least three restrains are specified for the 

structure.  

Another common error is the definition of only one load stage in the Job file. In this case, the analysis 

will terminate after this load stage. Please use more load stages to resolve this problem. 

5.3 Visualizing the Analysis Results 

To view the results from the VecTor5 analysis, you can use the Janus post-processor, which reads the 

output text files one by one and displays the results in a graphical manner. First, open the Job file 

using the top menu of Janus. You will see the VT5 View Options menu shown below, which will 

provide options. You can adjust the view options or change the load stages using the + and – icons. 

You can also set a particular load stage. The example below shows load stage 12. The crack locations 

and crack widths can be seen; white lines represent minor cracks of less than 0.1 mm; black is up to 

0.1 mm width; bold black up to 1 mm width; and red lines are for cracks larger than 2 mm. For the 

reinforcement, green is first yielding, yellow is strain hardening, and red lines is for rupture. Refer to 

the User’s Manual of Janus and watch-and-learn videos.  
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6. TOOLBAR MENUS 

An alternate method of creating the structure is using the menus on the top of the screen as discussed 

below.  

6.1  File 

The first menu is File. This menu allows the user to create a New structure or Open an existing one. 

Also, the user can Close, Save, Save As, or Print the structure which is currently being created. In this 

menu, the user can also Exit the program.  

 

6.2  Edit 

This menu is currently inactive. 

6.3  View 

The next tab is the View menu, shown below. The user can set the Limits of the display, as shown 

below. There are also options to Zoom to show the entire structure, a specific window, as well as 

zoom in and zoom out. There are options to Pan across the screen, and Display Options.  
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6.4  Job  

Next to the View menu is the Job menu. Here, the user can open the Define Job dialog, and Save the 

Job File. The Job menu is used to create the VecTor.JOB file. 

 

6.5  Structure 

The next option is the Structure menu. The user can view the Structure Information, Define the 

Materials, Define and Mesh the structure, create nodes and elements, as well as view the Structure 

Limits. It is recommended that you use the auto-meshing feature discussed above rather than using 

this menu. 

 

6.6  Load 

The following menu refers to the Load information. In this menu, the user can activate the Load cases, 

Apply Nodal Loads, Apply Element Loads, Ground Acceleration, Clear the Load Case, Save the Load 

Case File (.L5R), as well as view the Load Limits of the structure.  
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6.7  Analysis 

The next menu is for the Analysis. In this menu, the user can Run the VecTor Processor and the Janus 

post-processor. With the Janus postprocessor, the user can view the reactions and failures of the output 

members. This is a very useful program, which is discussed in its entirety in the Users Manual for 

Janus.  

 

6.8  Window 

Next is the Window menu. In this menu, the user can create a New Window, Cascade and Tile the 

windows, as well as Arrange the Icons. This is useful for keeping your work organized.  
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6.9  Help 

The final menu in the toolbar is the Help menu. Here, the user can view which version of FormWorks 

Plus is being used to create the structure. The program for this manual is Version 1.0. 

 

6.10  Toolbar Icons 

Below the toolbar, there are icons for accessing the premier features of the toolbar menus. The buttons, 

respectively, are New, Open, Save the Workspace, Print, Zoom All, Zoom In, Zoom Out, Zoom 

Window, Display Options, Increase Text Size, and Decrease Text Size. It is very important to 

frequently save the workspace file while creating the structure to avoid losing your work. 

 

7. CONCLUSION 

This manual allows the FormWorks Plus user to become familiar with the use the program to prepare 

text files for an analysis with VecTor5. Using FormWorks Plus to prepare the text files will allow 

VecTor5 analyses to be performed on structures of any complexity. To better understand the VecTor5 

program and the process behind the FormWorks Plus graphical interface, it is highly recommended 

to read the User’s Manual of VecTor5 and the User’s Manual of Janus for VecTor5, both of which 

can be downloaded here. Watch and Learn videos can be found here. These videos show how to use 

the programs to model various structures. 

 

http://www.utoledo.edu/engineering/faculty/serhan-guner/Publications.html
https://www.youtube.com/user/gunerser

